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Noventri Suite 
Schedule Tab Manual 

 
1 Overview 
 

1.1 The Schedule tab, through communication with the Noventri Server 
can Schedule Projects to play on Noventri Eco- Series line of 
Players.  
 

1.2 The Schedule options are only used if the Player is Networked. The 
Schedule tab is not used for Sneakernet Players. 

 
1.3  To use the Schedule tab, Log on to a Noventri Server that is  
 installed and running on the same computer as the Noventri  
 Suite or on another computer. 

 
1.4  To create a Schedule, there must already be a Project/Sequence 

created, that has been Published to the Server. 
(see the Noventri Suite Design Tab Manual)  

 
1.5 To Assign a Schedule to a Player, there must already be a Player  

connected to the Server.  
(see the Noventri Suite Manage Tab Manual) 

 
  
 

2 Start Schedule 
 
2.1  To create a new Schedule, select the Schedule tab.  

 
2.2 If the Suite is not already connected to the Noventri Server, the  

Noventri Server Login dialog will come up.  
(See the Login to Noventri Server section of the Design Tab Manual) 

 
 
 



 
 
2.3 After logging in, the Noventri Suite will synchronize with the Noventri  

Server. 
 
 

2.4 Once the Schedule tab has been selected and the Suite is connected  
to the Server, the following window will be displayed. 

   
 

 
 

 
2.5  The Schedule window has the following components. The Menu Bar,  

the top row of Load/Save Buttons, the top Arrangement Panel, the  
Sequences Panel on the left, the lower left Calendar Panel, and the  
main Editing Panel.    
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3 Menu Bar 
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3.1  File > Load Schedule  

 

 
 

 
3.1.1  These two selections, Load From Local Media and Load From  

Server allow the Schedules that already exist to be 
viewed/edited.   

 (see the Load/Save Buttons section of this manual) 
 
 
 
 
 
 
 
 
 



 
 
 

3.2 File > Save Schedule  
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3.2.1 These two selections, Save To Local Media and Assign to  

Player/Group allow the current Schedule that is being viewed  
to be Saved. 

 
The Save To Local Media saves the Schedule to the local  
computer/network.  
(see the Load/Save Buttons section of this manual) 

 
The Assign to Player/Group saves the Schedule to the 
Server and links the Schedule to the selected Player/s.  
(see the Editing Buttons section of this manual) 

 
 

3.3 File > Advanced > Snap On/Off 
 

 
 

 
3.3.1  The Snap is On by default to make Scheduling fast and 

simple. For example, when moving a Schedule entry in the 
Editing Panel it will snap (butt against) the near by Schedule 
entry.   
 



3.3.2  Turning the Snap to Off will allow the Schedule entry to be 
moved around to precise locations without it automatically 
butting to nearby Schedule entries.  
 
 

3.4 File > Clear Workspace 
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3.4.1 This allows the Schedule Entry Work Area to be cleared  
 without saving. 

(see the Editing Buttons section of this manual) 
 
 

3.5 File > Exit 
 

 
 
 

3.5.1  Exit will close Noventri Suite. This can also be done using Alt-F4. 
 
 
 
 
 
 
 
 



 
 

3.6 Server > Disconnect 
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3.6.1 This selection will let the Suite, Disconnect from the Server.  

This will also close the Schedule tab. Reselecting the 
Schedule tab will prompt the user to reconnect to the Server. 
(See the Login to Noventri Server section of the Design Tab Manual) 
 
 

3.7 Help > Customer Portal 
 
 

 
 
3.7.1 Coming soon! A link to Noventri.com information. 

 
 

3.8 Help > Check for Updates 
 

 
 
 
 



 
 
3.8.1 Opens the Noventri.com Forum that has the latest  

available Noventri Suite available to be Downloaded. 
 
 

3.9 Help > Report a Bug or Request a Feature 
 

 
 
 

3.9.1 Opens the Noventri Suite Bug Reporter Window.  
 

 
 
 

3.9.2 Submitting information via the Bug Reporter will send it directly to  
 Noventri Suite developers for evaluation.  Or the report can select Save  

Copy to save the report on the computer/network for future reference. 
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3.10 Help > Noventri Support 
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3.10.1 Opens Noventri.com Support website. 
 
 

3.11 Help > About 
 

 
 
 

3.11.1 Opens an information window that shows the current Noventri  
Suite software version being used, along with Contact  
information, and License Agreement. 

 

 



 
 

4 Load/Save Buttons 
 

 
 
 

4.1  Overview 
 
4.1.1 These Load/Save Buttons allow Schedules to be saved  

and retrieved from the local computer/network  
location and also gives the ability to retrieve or delete  
Schedules on the Server.  
 
Note:  Saving a Schedule to the Server must be done  

using Assign to Player/Group. 
 (see Assign to Player/Group section of this manual) 
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4.2  Load From Local Media 
 

 
 
 
4.2.1 If there is a previously created Schedule that is located on the 

local computer or a network location, it can be loaded and 
displayed in the main Editing Panel to be used and/or to be 
modified. 

 
Note:  A prompt will appear allowing the current Schedule 

displayed on the Editing Panel, to be saved before 
loading a new Schedule. 

 
4.2.2 Load From Local Media can also be selected through  
 File, Load Schedule, Load From Local Media. 

 

4.3  Save To Local Media 
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4.3.1 The current Schedule displayed on the main Editing Panel can  

be save to the local computer/network location. This is helpful to  
save a Schedule for future use.  

 
Note: Saving a Schedule using this Save To Local  

Media option will not save the Schedule to the  
Server or Assign it to Player/s.   

 
4.3.2 Save to Local Media can also be selected through File, Save  

Schedule, Save to Local Media. 
 
 
 



 

 

4.4  Load From Server 
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4.4.1 When Load From Server is selected the following Schedules  

on Server window will be displayed. 
 

4.4.2 Load From Server can also be selected through File, Load 
Schedule, Load From Server. 

 

 
 
 
4.4.3 If there are already Schedule/s on the Server they will be  

listed.  
(see the Assigned to Player/Groups section of this manual) 

 
Note: If the Schedule chosen to be Loaded is currently 

Assigned to a player, the Edit button can also be used 
to Load the Schedule into the Edit Panel. 
(see the Arrangement Panel section of this manual) 
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4.4.4 To Load a Schedule from this list. Select the Schedule to be  
Loaded, and then select the Load button. It will then be loaded  
and displayed in the main Editing Panel for re-use and/or to be  
modified. 
 

Note:  A prompt will appear allowing the current  
Schedule displayed on the Editing Panel, to be  
saved before loading a new Schedule. 

 
 
4.4.5 To Delete a Schedule from this list. Select the Schedule to be  

Deleted, and then select the Delete button. It will then be 
Deleted from the Server.  
 

Note 1:  If a Schedule is Deleted that is currently  
playing, the Player will continue to display  
the last image it received and it’s status will  
change to “Nothing Scheduled”. 
 

 Note 2:  Care should always be taken not to  
accidentally delete a Schedule from the  
Server that may have to be used again.   
 

 
4.4.6 Select the Exit button to close the Schedules on Server 

window.  
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

5 Arrangement Panel 
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5.1  The top panel is the Arrangement Panel and is used for selecting the  
Project to be Scheduled, and the Player/s that will be Assign to the 
Schedule.  
 

5.2  Project on Server 
 

 
 
5.2.1 The first step in creating a Schedule, is to select a Project that  

is on the Server. 
 

5.2.2 Select the Project on Server drop down menu and the 
Projects that are on the Server will be displayed. Select  
the Project to be used in the Schedule. 
 
 
 
 
 
 
 
 



 
 
 

5.2.3  After the Project is selected, the Sequences for that project will  
be shown in the Sequences panel. 
 

 
 
 

5.3  Player Single/Groups  
 

 

 
Noventri Suite - Schedule Tab Manual 

SF200-0162-02 REV 04 
12/10/13 

 
Page 16 of  59 

 
 
5.3.1 To Assigned a Schedule to a Player or a group of Players, 

first the selection needs to be made in the Single/Groups 
selection box. Choose between a Single Player or a Players 
Group. 

 

 



 

 

5.4  Select Player / Select Group 
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5.4.1 A specific Player or a specific group of Players needs to be 

selected so the created Schedule can be Assigned to them. 
 

5.4.2 When selecting a Single Player the Select Player drop down  
menu will show all the individual Players that the Server has a  
record of. 
 

 
 
 

5.4.3 When selecting a Group of Players the Select Group drop  
down menu will show all the Groups that have been created  
previously. 
(see the Player Groups section of the Manage Tab Manual) 
 

 
 
 
 
 
 
 
 
 



 

5.5  Currently Playing 
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5.5.1 When a specific Player has been selected that already has a  

Schedule Assigned to it. The Schedule name will be displayed  
as Currently Playing. 
 

 
 

5.6  Edit  
 

 
 
 

5.6.1 To view or change the Currently Playing Schedule, select the  
Edit button. The Schedule will then be displayed in the Editing  
Panel.    
 

5.7  Apply as Override  
 

 
 
 
 
 
 



 
 

5.7.1 The Apply as Override check box allows a temporary 
Schedule to be used immediately for a temporary period of 
time. 

 

 
 

 
5.7.2 For a Schedule to be used as an Override, first Load/Edit an  

existing Schedule from the Server, or create a new Schedule. 
(see the Load From Server or Edit section of this manual) 

 
5.7.3 When the temporary Schedule is correct, select the Apply as  

Override checkbox. The following window will be displayed. 
 

 
 
 

5.7.4 Choose the date and time the Override should stop playing  
using the Date Override Expires selection box and the Time  
Override Expires scroll bar.  

 
Note: The Override will begin as soon as the Schedule is 

Assigned to a Player/Group and will continue 
Playing until time it is set to Expire. 

 
Important:  When this new temporary Schedule is Assigned to  

Player/Group, a new File Name has to be created for it,  
to assure that the original Schedule remains as it was.  
Be sure to keep the original Schedule available on the  
Server for use after the Override Expires. 
(see the Assign to Player/Group section of this manual) 
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5.7.5 The Override Schedule will be active until the Override Schedule  

Expires. At that time the active Schedule will change back to the last  
Schedule that was Playing before the Override was Assigned to  
Player/Group. The now, inactive Override Schedule will remain on  
the Server.   
 

5.8  Play Every Week  
 

 
 
 
5.8.1 Once a Schedule for the week has been created  

(see the Editing Panel section of this manual), it can be  
repeated every week by selecting this Play Every Week  
checkbox. 

 

 
 
 

Note 1:  The weeklong schedule that will be repeated is  
  always the week beginning with the Start Date.  
  This does not necessarily match the week that is  
  being viewed.   
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5.8.2 Play Every Week option will Play the Schedule indefinitely and 

allow the SF-200 to continue Playing it’s Schedule when it no 
longer has it’s Date and Time set. This can happen in the 
following scenario 
 
 When a Player re-boots, this will cause the 

Players Time to be reset. If the Player is unable 
to establish a connection to the Server, it’s Time 
will not be reset correctly.  

 
If the Play Every Week option is selected,  
the Player will continue to Play it’s Schedule,  
however the day of the week and time may be 
incorrect until the Server connection is re-
established.  
 
Note:  If the Play Every Week option is not  
 selected, the Player will display a blank  

screen until the Server connection is re- 
established.  

 
5.8.3 Once Play Every Week has been selected the Calendar  
 Panel and the Week Long Scroll Column can no longer  
 be used.   

 
 

5.8.4 The Calendar and Week Long Scroll Column will show  
 the month/week that was last displayed and this may or may not  

contain the Week Schedule that will be repeated.  
 

5.8.5 To display the Week Schedule that will be repeated in the 
Calendar and Week Long Scroll Column areas, save the  
Schedule using Save to Local Media and then re-open it using 
Load from Local Media. 
 
 
 
 
 
 
 
 



 

6 Sequence Panel 
 

 
 
 
 
6.1  Once a Project has been selected the Sequences for that Project will 

be displayed in this panel with a thumbnail image for each one. 
(see the Project on Server section of this manual) 

 
Note:  If the Project does not have a Sequence created containing  

Pages, an error message will be displayed. 
 
 

6.2  The Sequences that are shown in this panel can then be selected to  
be part of the Schedule. 
(see the Schedule Entry Work Area of this manual)  
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7 Editing Panel 
 
7.1  The Editing Panel is the main area of the Scheduling tab window. It  

is where Schedules are created, viewed, and edited.  
  
 

7.2  The Editing Panel has four areas, the Week Long Scroll Column on  
the left, the TimeLine across the top, the main Schedule Entry Work 
Area, and the Editing Buttons on the bottom. 
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  7.3  Week Long Scroll Column  
 
 
7.3.1  Week Long Scroll Column is the reference to the  

specific week of the Schedule that is being viewed. 
 
7.3.2 The Week Long Scroll Column defaults to the  

current week with the current date on top. 
 

7.3.3 The Week Long Scroll Column will  show days of  
the past in red. While it is possible to set a schedule  
on those days, it will not be played. They are there  
shown for reference to entries that have already  
played. 

 
7.3.4  The first step to starting a Schedule creation in the  
 Editing Panel is to select a Starting Date. 

 
7.3.5 Selecting a Starting Date is done by selecting a  

date on the Week Long Scroll Column. 
 

7.3.6  The Week Long Scroll Column has arrows on the  
top and bottom that allow it to be scrolled to the desired week.  

 
Exception: When Play Every Week is selected, the  
  Week Long Scroll Column will no longer  
  be scrollable. It will continue to show the  

last week that was being displayed when Play  
Every Week was selected. 

 
7.3.7 The Calendar can also be used for selecting the week that is  

displayed. 
(see the Calendar Panel section of this manual) 

 
Note:  The top date in the Week Long Scroll Column will  

always match the selected date shown on the Calendar. 
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7.3.8 Once the Week Long Scroll Column is displaying the desired  

week, that contains the desired Starting Date, the Starting  
Date can be selected. 

 
7.3.9 The date selected will be temporarily marked with a white  

boarder. 
 

 
 
 

7.4  Timeline 
 
7.4.1 Once a Start Date has been selected, the Start Time can be selected 

using the Timeline Marker.  
(see the Week Long Scroll Column section of this manual) 
 

 
 

 
7.4.2 The Timeline Marker can be moved in 15min increments 

across the day by dragging the Marker with the mouse or by 
using the left and right arrow keys on the keyboard. 
 
Note: To enable the keyboard arrow keys to operate for the  

Timeline, select the Timeline first by using the mouse to  
click on it.  
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7.5  Schedule Entry Work Area 
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7.5.1 In this  Schedule Entry Work Area the Schedule will be built by  

adding Sequences.  
 
  7.5.2 Prior to adding a Sequence to the Schedule a Project must  

first be selected. 
(see the Project on Server section of this manual) 

 
and  

 
Have a date/time selected. 
(see  the Week Long Scroll Column and Timeline sections of  
this manual)  
 
 
 
 



 
 

7.5.2 In the Sequences panel, select the Sequence to be added into  
the Schedule. It will appear as a colored bar in the Schedule  
Entry Work Area at the date and time previously selected. 

 
Note: The colored bar will match the Sequence border color  

shown in the Sequences panel. 
 

 
 
 

7.5.3  Once a Schedule entry is added to any given Date, that Date  
will now appear as red in the Calendar Panel. 

  

 
 
 

7.5.4  The default length for each Sequence when added is 30  
minutes.  
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7.5.5  Hovering the mouse over the colored bar will display a tooltip  
with information about this Schedule entry. The following  
information will be shown in the tooltip... 
 

 
 
  Proj: Project Name 
 
  Seq: Sequence Name 
 
  Scheduled Start Time: Day and time of week that  

       this entry will start playing. 
 

  Scheduled Stop Time: Day and time of week that  
      this entry will stop playing. 

 
Schedule Duration:  How long the entry will play. 
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7.5.6  Double clicking on the colored bar for the Schedule entry will  
open the Edit Schedule Entry window. The Edit Schedule  
Entry window allows the Schedule entry to be fine-tuned. 
 

 
Note: The Schedule entry properties that can be changed in the Edit  

Schedule Entry window can also be changed directly in the  
Schedule Entry Work Area using the mouse. 
(see the Work Area Management section of this manual)  
 

 
 
 
Project Name –  Project Name used for this  

Schedule entry (ref only). 
 

Sequence Name –  Sequence Name used for this  
Schedule entry (ref only). 

 
Sequence Length – How long one rotation of this  

 Sequence will take. (ref only) 
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Date – The Date that this Schedule entry will play.  

  Changing this Date will move the color bar  
  for this Schedule entry to the new Date.  
 
Note: If a Date is selected outside the 

Schedule Entry Work Area (area 
that currently being viewed), the 
color bar will not be visible for this 
Schedule entry. 

  
To bring it into the Schedule Entry  
Work Area, Scroll to it using the 
Week Long Scroll Column,  
or select the new Date in the Calendar  
Panel. 
 
 

Start/Stop Time –  Allows the playing Start and Stop  
time of Sequence entry to be  
precisely set. Unchecking the  
Maintain Duration checkbox will also  
allow the Scheduled Length of the 
entry to be adjusted. 
 

Scheduled Length – How long the entry will Play. 
  This can be adjusted by changing  
   the Start Time or Stop Time. 
 

Maintain Duration – This feature allows the Start Time or  
  Stop Time to be adjusted without  
  having to readjust the other.  
   This will keep the entry Scheduled  
   Length the same. 

 
 

    Expand This Sequence All Day – Selecting this button 
    will expand this Schedule entry  
    to play all day.  
    From 12am (00:00:00) to   
    11:59:59pm (23:59:59). 
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Repeat This Sequence All Week – Selecting this  

    button will copy this Schedule  
    entry to the same time each day     
    of the week currently showing. 
 

OK –        Select OK and the changes  
    made will be reflected in the  
    Schedule Entry Work Area. 
 

Cancel -       Select Cancel to discard any  
    changes. 
 
 
 

7.5.7  Work Area Management  
 
7.5.7.1 Schedule entries can also be modified directly in  

the Schedule Entry Work Area without having to  
enter the Edit Schedule Entry window. 

 
 

7.5.7.2 Move Entry - To move a Schedule entry without  
changing its duration, use the mouse to drag it to  
the desired new location within the week. 

 
 

Snap: When moving the schedule entry around, it  
will snap to other schedules when they are  
close. This is turned on by default to make  
scheduling fast and simple. 
To enable or disable this feature, go to  
File, Advanced, Snap Off/Snap On. 

 
 
 
 
 
 
 
 
 
 



 
 
7.5.7.3 Duration - To adjust the Start or Stop time of a  

Schedule entry, use the mouse to grab its border  
and drag it to the desired new time. 

 

 
 
 

Note: The minimum Duration for a Schedule  
entry is 15 minutes. 

 
 

7.5.7.4 Delete – To Delete a schedule entry, using the  
mouse, right click on the entry and select Delete.  

 

 
 

 
 

7.5.7.5 Edit – To Edit the Schedule entry, use the 
mouse, right click on the entry and select Edit.  
The Edit Schedule Entry window will open.  
(see the Schedule Entry Work Area section of this  
manual) 
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7.5.8 Insert Command  

 
7.5.8.1 The Insert Command option allows external 

devices to be controlled through the SF-100e 
RS232 port or through the SF-200 USB Port.  
(see the External Devices section of this manual)  

 
 

 
 

7.6 Editing Buttons 
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7.6.1 Clear Workspace 
 
7.6.1.1 To clear the Schedule Entry Work Area without 

saving, select the Clear Workspace button.  
 

7.6.1.2 Clear Workspace can also be selected through File,  
Clear Workspace. 

 
7.6.1.3 If there are Schedule entries present (visible or not),  

they will be deleted and the Week Long Scroll Column  
will be reset to the current date week.  

  

7.6.2 Assign to Player/Group 
 
7.6.2.1 The Assign to Player/Group is the only way a  
  a Schedule can be sent to a Player to be played. 

 
7.6.2.2 Assign to Player/Group can also be selected through  

File, Save Schedule, Assign to Player/Group. 
 
   7.6.2.3 Prior to Assigning a Schedule to a Player a  

Schedule needs to be created. 
 

Note: A Player or Group of Players must be selected. 
 (see the Select Player / Select Group section of  

this manual) 
 
 

7.6.2.4 Once the Schedule is complete, select the Assign to  
Player/Group button.  

 
 
 
 
 
 
 
 
 
 



 
 
 

7.6.2.5 When Assign to Player/Group button is selected  
the following Schedules on Server window will be  
displayed. 

  

 
 
 
7.6.2.6 If there are already Schedule/s on the Server  

they will be listed.  
 

7.6.2.7 To Save the Schedule. Enter a Schedule 
filename or select an existing Schedule that is 
listed to overwrite.  

 
7.6.2.8 To Delete a Schedule from this list. Select the 

Schedule to be deleted, and then select the 
Delete button. It will then be Deleted from the 
Server.  

 
Note 1:  If a Schedule is Deleted that is currently  

playing, the Player will continue to display  
the last image it received and it’s status will  
change to “Nothing Scheduled”. 
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Note 2:  Care should always be taken not to 

accidentally Delete a Schedule from the 
Server that may be used again.   
 

 
7.6.2.9 Select the Exit button to close the Schedules on  

Server window.  
  

  

8 Calendar Panel 
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8.1  The Calendar Panel is a convenient way of selecting the week that is  

displayed in the Week Long Scroll Column. 
 

 
 

 
8.2  The Calendar Panel defaults to the current month with the current 

date selected. 
 

8.3 Selecting a calendar date will update the Week Long Scroll Column  
with the selected date at the top. 

 
Note:  The top date in the Week Long Scroll Column will  

always match the selected date shown on the Calendar.  
 
 

8.4 If the week to be viewed is not in the current month or year, use the  
month and year selection boxes to navigate to the desired month/year. 

   
 

8.5  Selecting a calendar date can be done by clicking on it with the mouse  
or by using the keyboard arrow keys. 

 
Note: To enable the keyboard arrow keys to operate for  

the Calendar, select the Calendar by using the  
mouse to click on it.  

 
8.6  Once a date on the Calendar has a Schedule, it will appear on the  

Calendar as red. 
 

Exception: When Play Every Week is selected, the Calendar  
will only show the initial week in red. 
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9 External Devices  
 
9.1 External Devices (such as a monitor) connected externally to the 

Player through it’s RS232 port, can be controlled using Serial 
commands.  

 
 Note: The SF-200 connects to an External Device through one of it’s  

USB connectors and the SF-100e through it’s DB-9 connector. 
(see the SF-200 Manual or the SF-100e Manual) 

 
9.2  These External Devices can be controlled in the Schedule by adding 

a Command Marker. A Command Marker is a small colored circle 
that is entered on a Schedule that is then configured to control the 
External Device with Serial commands.  

 
 

9.3  To add a Command Marker to the Schedule, hover the mouse in the  
Schedule Entry Work Area, right click on the mouse, and select Insert  
Command.     
(see the Schedule Entry Work Area section of this manual)  
 
Note: Don’t be concerned about what day or time it has been entered,  
 this can be adjusted later. 
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9.4  A small Command Marker (circle) will appear in the Schedule Entry 
Work Area.  

 

 
 

Note: The color of the Command Marker circle on the Schedule  
Entry Work Area will default to a random color. However if any 
change is made to it’s Command String(s), the color will 
automatically change. The color will not change if the 
Command Marker’s location is changed. In other words, if it’s 
Date, Start Time, or Repeated All Week are changed, it’s color  
will remain the same. 

 
 

9.5  Right clicking on the Command Marker with the mouse will open the 
Command menu.  

 

 
 
 
 

9.5.1 Delete –  This will Delete the Command Marker from the  
Schedule Entry Work Area. 

 
9.5.2 Edit –  This will open the Edit Schedule Entry window  

for this Command Marker. 
     (see the Edit a Command section of this manual) 
 

9.5.3 Insert Command – Allows the insertion of additional Command  
Marker entries. 
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9.6  Edit a Command Entry (Edit Schedule Entry window)  
 

Note: Each Command Marker Entry can be configured to send  
 multiple Serial Commands.  

   
 

9.6.1 Once a Command Marker has been added to the Schedule 
Entry Work Area, it can be configured. Right click on the 
Command Marker with the mouse, and select Edit. This will 
open the Edit Schedule Entry window for this Command 
Entry. 

  

 
 
 

9.6.2 Device  
 

9.6.2.1 Select the Device to be controlled.  
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9.6.2.2 The Device drop down menu will show previously  

listed Devices. If the Device to be controlled does  
not appear in this drop down menu, it will need to 
be added. 
 

Note 1:  Each Device has a list of RS232  
Commands that control it. This list is a Serial  
Command Language (.scl) file. Referred to as  
an SCL File. An SCL File for a Device can be  
obtained from the Device manufacturer. 

 
Note 2:  For convenience, the Noventri.com - Forum  

contains downloadable SCL Files (Command  
Lists) for the NEC and LG monitors.  

 
Note 3:  Once a SCL Files (Command Lists) is  

chosen, it will remain accessible by Noventri  
Suite. However, when Commands are used, 
the SCL File never fully transports to the 
Player. The Player only receives the individual 
Commands. To copy the SCL File to another 
location, use the Export option. 
(see the Device Editor – Export section of this 
manual)    

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
9.6.2.3 To add a new Device (SCL File) or to use the  

Device selected in the drop down menu, select  
Edit. The Serial Device Editor window will be  
displayed. 
(see the Device Editor section of this manual) 
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9.6.3 Command String Entry 
 

9.6.3.1 Once a Device has been selected, Command 
Strings can be chosen for the specific Device that 
is connected to the SF-200. Once chosen, these 
Command Strings will be partially visible in the 
Command(s) box. 

 

 



 
 

9.6.3.2 To create or edit this List of specific Command 
Strings for the selected Device, select the Edit 
button to the right of the Command(s) box. The 
Command Selection window will open. 

 (see the Command String Selection section of this 
manual) 
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9.6.4 Date/Start Time 
 
9.6.4.1 The Date/Start Time shown in the Edit Schedule  

Entry window. It is the Date and Time that this  
Command Entry will be executed. 
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9.6.4.2 The Date/Start Time can be changed here. This  
will automatically move the Command Marker to  
the new location in the Schedule Entry Work  
Area. 

 
 

9.6.5 Repeat This Sequence (Command) All Week  
 

9.6.5.1 Selecting the Repeat This Sequence All Week 
button will put a copy of this Command Marker on 
the Schedule Entry Work Area every day of the 
week. 

 
        Note 1:   The week that will be populated with this  

Command Marker will be the current  
visible week that is showing on the  
Schedule Entry Work Area.    
 

        Note 2:  Any changes made to one of the  
Command Markers after it has been  
repeated all week (this includes Device,  
Commands, Date, or Start Time) will only  
affect the one Command Marker that is  
selected.  
 

 
9.6.6 Cancel/Ok 
 

9.6.6.1 Once the Command Entry information is 
complete, select Ok, or to close the window 
without making any changes to the Command 
Entry, select Cancel. 

 
 
9.6.7 When the Schedule is Assigned to a Player, Command  

Entries that have been added will be executed at their specified  
times. 



 

9.7 Device Editor (Serial Device Editor window) 
 

9.7.1 The Serial Device Editor window is where SCL Files are 
added, viewed, and controlled. 

 

 
  
 
9.7.2 Device List – the Device List drop down menu is the same list  

shown on the Edit Schedule Entry window, and is a list of  
previously listed Devices.  
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9.7.3 Add – Allows a new Device (SCL File) to be added and opens  
a window that allows it’s communication parameters to be 
configured manually. 
(see the Device Properties section of this manual) 
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9.7.4 Import – Allows a new  Device (SCL File) to be added from an  
existing source (such as one that has been downloaded from  
the Device manufacturer). To Import, browse to the Device  
List to be added and select Open.  

 
Example: NEC.scl 
 
 

 
 
 
 

9.7.5 Edit – For Devices that are already entered, selecting Edit  
will open the Serial Device Properties window to allow  
configuration of it’s communication parameters.  
(see the Device Properties section of this manual) 
 

 
 



 
 

9.7.6 Delete – Devices (SCL Files)  that are already on the Device 
List can be removed by selecting the Device and then selecting 
the Delete button.  
 

 
 
 

9.7.7 Export – Once a Device (SCL File) has been created and/or 
configured as desired, it can be Exported for use elsewhere. 

 

 
 
 
9.7.8 The Device Command List section shows all the Command  

Strings  that are listed in the selected Device’s SCL File. 
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9.7.9  Name – The Name column shows the individual  
Command Strings. The Name typically describes what 
the Command String does. 

 
9.7.10  Command – The Command column shows the actual  

Command Characters that are used when a Command  
String is sent to a Device. 

 
9.7.11  Add – Used to Add Command Strings if the SCL File is  

being entering/modified by hand.  
(see the Command String Editor section of this manual) 
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9.8 Device Properties (Serial Device Properties window) 
 

 Note: These settings can be obtained from the Device manual  
  or the Device manufacturer. 

 

    
 
 

9.8.1  Serial Device Name – Defaults to the next Device  
number, or can be filled in with any desired Name. 

 
9.8.2  Serial Device Communication Parameters – These  
  settings include Baud Rate, Data Length (Bits), Parity,  

Stop Bits, and can be obtained from the Device manual  
or the Device manufacturer. 

 
9.8.3 Command Delay – this is a forced Delay between 

sequential Command Strings. Most Devices have a 
limit to how fast they can accept Command Strings. 

 
9.8.4  Cancel/Ok - Once the Serial Device Properties  

information is complete, select Ok, or to close the  
window without making any changes select Cancel. 
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9.9 Command String Editor (Serial Command Editor window) 
 

9.9.1 The Serial Command Editor window is where individual 
Command Strings are managed. 

 

 
 
 
 

9.9.2 Name - The Serial Command Name is added or edited here. 
Typically the Name describes what the Command String does. 
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9.9.3 Special Char. –  Special Characters are building blocks that 

are used in the creation of Command Strings. The list of all the 
available Special Characters can be seen by using the Special 
Char. drop down menu. 

 
 

Note: The Special Characters are convenient and helpful  
when creating/editing Command Strings or interpreting  
existing Command Strings.  

 
 

 
 
 
 
9.9.3.1 Insert – Allows Special Characters be quickly  

and accurately entered into Serial Commands as  
they are assembled in the Command box.  
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9.9.3.2 Add – Allows a Special Character be created and  
added to the drop down list of Special Characters. 
(see the Special Character Properties section of  
this manual) 

 

 

 
Noventri Suite - Schedule Tab Manual 

SF200-0162-02 REV 04 
12/10/13 

 
Page 52 of  59 

 
 
 

9.9.3.3 Edit – A Special Character that has been created  
can be open and Edited.   
(see the Special Character Properties section of  
this manual) 

 
    Note: The default Special Characters cannot be Edited. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

9.9.3.4 Delete – Special Characters that have been  
created and are now listed on the Special  
Character drop down menu can be removed by  
selecting Delete.  
 

Note: The default Special Characters cannot be Deleted. 
 

 
 
 

9.9.3.5 Command – The Command box shows the  
Command Characters that are being Added or  
Edited to form the Command String. Changes 
can be made by typing in Characters by hand or 
by using the Special Character Insert button. 
 
 

 
 
 
9.9.3.6 Cancel/Ok – Once the Command String - 

Add/Edit is complete, select Ok, or to return to the 
Serial Device Editor window without saving, 
select Cancel. 
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9.10 Special Character Properties 
 

9.10.1 Special Characters are keyboard key strokes or combination of 
key strokes represented by a code and used as building blocks 
in the creation of Command Strings.  

 
9.10.2 The Special Character Properties window allows a Special  

Character to be created and added to the drop down list of  
Special Characters.  
 

 
 
 
9.10.3 Description – This is a name for the Special Character and  

should describe what it is or it’s function. 
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9.10.4 Char. Code – This box would be filled in with the ASCII Code  

for the Special Character being added. 
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9.10.4 Base – These radio buttons allow the format of the Char. Code  
to be selected. Either Decimal, Hex, or Octal.  

 

 
 
 

9.10.5 Escape seq. – Shows the Octal equivalent of the Char. Code.  
It is this Octal equivalent that will be Inserted into a Command 
String when this Special Character is selected.. 

 

 



 
 

9.10.6 Cancel/Ok – Once the Special Character Add/Edit is  
complete, select Ok, or to close the window without saving,  
select Cancel. 

 
 

9.11 Command String Selection (Command Selection window) 
 

9.11.1 This Command Selection window is where the specific  
Command Strings for the Command Marker are chosen.  

 

 
 
 

9.11.2 The left side of the window, the Command List area shows all  
the Command Strings presently available for the Device that  
was selected.  
 

9.11.3 The right side of the window, the Chosen Command(s) area  
shows Command Strings that have been selected to be  
executed by this Command Marker. 
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9.11.4 To choose the Command Strings to be implemented by this  
Command Marker, select them in the Command List, then 
using the right arrow (Add) button, copy it over to the Chosen  
Command(s) area. 
 

 
 
 

9.11.5 To remove Command Strings from the Chosen Command(s)  
 area, select the Command String and use the left arrow  

(Remove) button to delete it. 
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9.11.6 The order that the Command Strings are listed in the Chosen  
Commands area will be the order that they are transmitted to  
the Device. To change the order, select the Command String 
to be moved and using the up/down arrows move the 
Command String to the desired placement. 
 

 
 
 

9.11.7 Cancel/Ok – Once the Chosen Command(s) are correct, 
select Ok, or to close the window without saving, select Cancel. 
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